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Before Using UM185C

This chapter provides important information about 
using the UM185C including:

About this User Manual
Product Overview

What’s Inside the Product Package
Introduction to Wireless UM185C USB Modem

Product Features
Product Handling

Configuration
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About this User Manual
You will find all the information you need to install and use the UM185C in this user manual. Before using the UM185C, you must properly install the Cricket 3G Broadband by 
closely following the installation instructions.

Instructions
•	 The software needed to install and configure your UM185C USB device is already included on the device.
•	 It is highly recommended that you read the safety precautions described in this manual before using the UM185C.

Product Overview 
Thank you for purchasing the Cricket Wireless UM185C USB Modem. The UM185C is a 3G wireless device that enables high-speed wireless communication from your laptop or 
desktop computer. The UM185C is simple to install and use.

What’s Inside the Product Package
The following items are included in the product package. If any of the items listed below are missing, please contact the retail location where you purchased the product.

•	 UM185C Wireless USB Modem
•	 Quick Start Guide

Introduction to Cricket UM185C Wireless USB Modem
The Cricket UM185C is designed for your laptop or desktop computer’s USB port, which is available in most models. The UM185C can be used to access the Internet, your 
company’s intranet, or you can use it to send and receive email. It is extremely useful when you are away from the office, on the road, or wherever a wireline Internet access is 
not readily available.

n	� Blue light: Connected to laptop or desktop computer and detected to network  
Red light: Connected to laptop or desktop computer but out of service status

Before Using UM185C

USB Connector

External Antenna 
Booster Jack 

(on the back side)

LED status  
indicator *
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Product Features
•	 Power management: The UM185C utilizes power management and system overhead reduction functions provided by the USB interface for maximum power savings.
•	 Antenna design: Efficient, innovative internal antenna design optimizes data transfer rate and sensitivity to network signals.
•	 USB Modem that supports Type A USB Port interface.
•	 Supports North American US_PCS, Cellular CDMA and AWS bands.
•	 Utilizes QUALCOMM QSC6085 chipset.
•	 Supports 3G network technologies.
•	 Maximum Data Rate: 3.1 Mbps download; 1.8 Mbps upload.
•	 Supports Windows XP and Vista systems with installed host software and driver.
•	 Compatible with Mac OS X 10.4.X (Tiger), 10.5.X (Leopard) or higher. 
•	 Provides Cricket Wireless Internet service. 
•	 The datacard cover automatically closes when you push the designated point as displayed in the following figure.

                                            

Product Handling
1.	 Do not put any adhesive label on the USB connector. It may leave a sticky residue that can cause problems inside the USB port.
2.	 The UM185C USB device should easily slide into the USB port. Do not force the UM185C into the USB port as it may cause damage to the modem and/or the 

port.
3.	 Keep the UM185C in a dry and clean place. (Storage temperature: -22°F to 149°F [- 30°C to 65°C]).  

Keep your device away from liquids, dust and excessive heat. 

Configuration
To use the UM185C, you should first install the software included on the device and configure the UM185C USB device. See the next section for more information on software 
installation and USB device configuration.
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The Cricket 3G Broadband and installation and setup 

procedure of your USB modem.

The Cricket 3G Broadband Setup Program
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This chapter will guide you through the installation and setup process for Cricket 3G Broadband. Before getting started, you should become familiar with the documentation 
that came with your wireless device.

Getting Started (WIN)
Follow these steps to install Cricket 3G Broadband:

1. 	 Turn on your computer and close all applications.
2.	 Insert the UM185C into the USB port.
3.	 If set up does not automatically start:
	 a. Click the Start Button
	 b. Choose My Computer
	 c. �Find and double click on the drive icon (Cricket 3G broadband) that represents the data card.
	 d. �Run the Start.exe file in the Windows Cricket 3G broadband folder to begin the installation
4.	 Follow the steps in the next section.

Getting Started (MAC)
Follow these steps to install Cricket 3G Broadband:

1.	 Turn on your computer and close all applications.
2.	 Insert the UM185C into the USB port.
3.	 Find and double click on the drive icon that represents the data card.
4.	 Find and run the Cricket 3G Broadband icon in the MAC Cricket 3G broadband folder.
5.	 Double click the Cricket 3G Broadband icon to begin the installation.
6.	 Follow the steps in the next section.

The Cricket 3G Broadband setup program (WIN)
STEP 1:  In the “Cricket 3G Broadband – License Agreement” screen, you will see the program user license Agreement. In order to install and use this product, you must agree 
with the terms of this agreement. Select “I agree” then click the “Next” button to continue. If you do not agree with this agreement, click the “Cancel” button to exit.

Installation and Setup
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STEP 2:  After agreeing to the License Agreement, you will see the “Cricket 3G Broadband - Setup Type” screen.  You can select from the two setup type – Express install or 
Custom Install. It is recommended that you choose Express Install. Click the “Next” button to continue.

STEP 3:  During this step, the components of Cricket 3G Broadband are being installed onto your computer.

STEP 4:  “The Install shield Wizard has successfully installed Cricket 3G Broadband“ appears on the screen. Click the “Finish” button.
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STEP 5:  The setup program will create an Access shortcut and the Cricket 3G Broadband will launch automatically. Now the installation is complete.
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The Cricket 3G Broadband setup program (MAC)
STEP 1:  Click the Cricket 3G Broadband setup program. When the pop-up screen appears to confirm installing the software, click the “Continue” button to continue with the 
installation process.

STEP 2:  The “Welcome” screen appears. Click the “Continue” button. 

STEP 3:  Read the “Read Me” screen and continue installing the software. You may “Print” or “Save” the “Read Me” file for future reference.

FPO

FPO

FPO
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STEP 4:  After the “Read Me” screen, you will see the Cricket 3G Broadband License Agreement. Carefully read the license agreement and press “Continue” to install the Cricket 
3G Broadband setup program.

In order to install and use this product you must agree with the terms of this agreement. Select the “Agree” button to continue. If you do not agree with this agreement, click 
the “Disagree” button to exit.

STEP 5:  You are now ready to select the location on your computer where Cricket 3G Broadband should be installed.

STEP 6:  During this step the components of Cricket 3G Broadband are being installed onto your computer. Installation will occur to the destination folder specified in Step 5 
above.

FPO

FPO

FPO
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Installing the software requires you to restart your computer when the installation is complete. Please check that no other programs are running, then press “Continue 
Installation”.

STEP 7:  While your computer is running the installer script, do not turn your computer off.

If you want to create an Access shortcut on your desktop, press “Yes”.

FPO

FPO

FPO
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STEP 8:  Installation is now complete. Click the “Restart” button to leave the Cricket 3G Broadband setup program and restart your computer.

FPO
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This chapter provides information about  
Cricket 3G Broadband software.

Features
Getting Started

Connecting
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Today’s online world offers more services everyday and Cricket Wireless gives you the tools you need to take advantage of the best in connectivity solutions. With Cricket 3G 
Broadband, enjoy the freedom and convenience of wireless Internet connectivity from your computer!

Features
WWAN (Wireless Wide Area Network, 1xEV-DO/1xRTT) Specific Features

•	 Configures your laptop or desktop computer to use your wireless device as a modem.
•	 Creates a Cricket Wireless Internet connection.
•	 Copy utility to create wireless copies of your dial-up connections, if supported by your device.
•	 Signal strength display for your Wireless USB Modem.
•	 Features a test function for your WWAN device.  

n	 A WWAN capable device is required to use the WWAN features. Individual WWAN features are also device dependent as described in the WWAN section above.

Other Features
• �Can also be used to launch all of your dial-up networking connections, if desired.
• �Can launch your browser, e-mail client, VPN or a program of your choice upon connection.
• �Logs connections used, duration and bytes sent and received.
• �See the section “Additional Features” for more information about the features of Cricket 3G Broadband.

Getting Started
Double click on the Cricket 3G Broadband icon on your desktop or click on the Windows Start menu and select Cricket 3G Broadband from the list of Programs.

WINDOWS MAC

About the Networks View
The Cricket 3G Broadband will open the Broadband Networks window by default. This view is where you manage your Broadband connections. The Broadband Networks 
window displays all currently available network connections.

At a glance you can see the signal strength. Your current connection state and the elapsed time of the connection are displayed along the bottom of the status bar.

WINDOWS MAC

FPO

FPO
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Connecting
Cricket 3G Broadband Connect allows users to connect to the data network by clicking one button on the main UI. This can also be access by selecting the File > Connect to 
Internet.

To help ensure users data usage stays within their data plans, there is an option in the application to set Cricket 3G Broadband Connect to Disconnect the Internet connection 
after a specific amount of time or after a specific amount of data has been exchanged.

When creating the Internet connection, Cricket 3G Broadband Connect must get the phone number from the device and include it as the username when needed.  The Data 
Connection is accessed using the modem or over NDIS.

Once your device is properly configured, connecting to the Internet is as simple as selecting the network connection type shown in the list and clicking the connect button.

Once connected, the Earth shape button will change to “Disconnect”. Simply click this to end your current connection. To connect to any other network shown, select it, and 
then select “Earth shape”.

The Status Bar
Information regarding your current network connection can be seen in the status bar along the bottom of the Cricket 3G Broadband interface. For more information on this 
status bar, see the section “The Status Bar” in the “Additional Features” section.

At any time during your connection you can check your current connection speed and throughput stats in the Statistics tab of the Session Information window. To see this 
window, select “Statistics” from the “View” menu.

The Connection Monitor window displays information about your data connection.

The Statistics section provides real time data throughput for current data connection.  The Received tab provides real time throughput.  The transmitted tab provides 
transmitted real time throughput.

The status section indicates the status, the duration and the speed of your connection.  This information is required to be the same as the information displayed on the main 
screen.

The Internet Protocol (TCP/IP) button displays the Internet Protocol (TCP/IP) windows shows the Internet Protocol properties.
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Additional Features
In addition to the basic features mentioned in previous sections, Cricket 3G Broadband has the additional features listed below.

Status Bar
The details of your current connection can be seen in the status bar at the bottom of Cricket 3G Broadband interface. This status bar is always visible when the interface is fully 
expanded.

Connection Status
The screen will show if the device is connected to the Internet. This should be done with the text string “Connected” and “Not Connected”.

   

Quick Launch icons
• Internet – Launch default Internet browser.
• Email – Launch default e-mail client
• TEXT MSG – Launch to send a SMS
• Connection Log – Launch Data connection logs
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The File Menu

Connect to internet
You can connect the wireless networks.

Exit
Exit the application.

The View Menu

Statistics
The main screen  shows you information about your data connection.  The data displayed is the Network Speed, Connection Duration, and the Bytes send and received.   
This information is required to be pulled from the device, and not from Windows.

Data connections log
Cricket 3G Broadband Connect contains a log file of all connection made using the application. The data in the log can be easily sorted by date, duration, bytes sent, bytes 
received, and total bytes. The data will be taken from the device and then deleted on the device and stored on the PC. This ensures if the user connects outside of the software it 
is still recorded into the log file.

The data that are recorded and stored in the log file are Numbered Dialed, Call Duration, Bytes Sent, Bytes Received, Total Bytes, Date/Time of call, Disconnect Errors (Errors 
recorded are the Windows errors received when making the connection).
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Text Messaging
When a new text message is received the text message icon on the main screen will flash.
Clicking on this icon will open the Text Msg Inbox.

Cricket 3G Broadband Connect will read the Text messages from the modem and display them in the inbox. 
This can be accessed though the main screen or by selecting View > Text Msg > Inbox.

   

The Inbox displays information about the message and give you the ability to create a new message, reply to an existing message, forward a message, and to delete messages.   
There is also the ability to create folders and organize the messages.
The default Text Message Inbox subfolders are
Outbox – Text messages waiting to be sent
Drafts – Text messages saved as Drafts
Sent Messages – Text messages successfully sent
Failed Transmissions – Text messages that failed to send
Inbox – Default folder new text messages are saved into

About device
About device will have the following Information.
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The Tools Menu

General Setup
General Setup allows users to make changes to the application.  This section is split into multiple parts.

The first section allows user to change and view what modems are active in the application.

Text Alerts tab
The section allows users to change the ring tone that is played when a SMS message is received.  The text needs to be changed to Text Alerts.

Miscellaneous tab
The second section displays the start up features.  Here you can select to start Connection Manager on Windows boot along with the ability to start the application minimized.

Start Cricket 3G Broadband on boot: Automatically launches Cricket 3G Broadband whenever you start your computer.

Start minimized: When you minimize the application it will now show in the Windows task bar. To restore the application click on the Cricket 3G Broadband tray icon.
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Internet Connection tab
The last option allows users to change the Internet options.  Here you can set Cricket 3G Broadband Connect to disconnect after a specific amount of time or data. You can also 
set Cricket 3G Broadband Connect to connect automatically when the application starts and the option to connect if the connection fails.  In the past the option to connect after 
the connection fails was dependent on starting the connection when the application starts.  This needs to be changed to be two separate options.

In the Internet Connection section, click the “Manually” button and then you can set up the disconnection:

1.	 Check the box.
2.	 Then click the corresponding radio button to define specific amount of time or data.
3.	 Use the scrolling list to select amount of minutes or Mb.

In the NDIS section, you can connect to the data network over modem or over NDIS. Check the box to use NDIS.

Move to another tab if necessary or click the OK button to confirm your choice. You can also set to connect automatically when the application starts and if the connection fails.

Control Panels
The control panels are accessed though the menu of connection manager. This section allows users to open new windows for details on their device and about their PC.

Modem control panel will open the Windows phone and modem details.

Network and Dialup Connections will open Windows Network Connection Page

Internet will open the Windows Internet Properties page

All will open the Windows Control Panel
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Dial Up Account
Add Wireless
Allows you to display the internet Connections window.

Add Other
Allows you to open the New Connection Wizard.
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The Option Menu
Refresh Network
This causes Cricket 3G Broadband to verify connected devices and to scan for available Networks. Use this feature if you connected your equipment after launching Cricket 3G 
Broadband. Pressing the F6 function key can also access this option.

Test WWAN Device
Test device communicates with the device to verify the following information.

•	 Results (If Connection Manager was able to communicate with the device)
•	 Manufacture
•	 Model
•	 Network Capability
•	 Current Coverage
•	 Software version of the device
•	 Device phone number

At the bottom of the window needs to be an option to retest and an option to close the window.

The option Network Capability will show 1XRTT/1X-EVDO-rev0/1X EVDO-rev A.

Connect a new device
Connect a new device allows users to setup a new device in Connection Manager.  Connection Manager will search for a new device based on the plug and play event.  
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Activation
Connection Manager must provide an option to initiate and terminate OTASP sessions.  An activation status is required.  The status will display to users that their device is 
activating.

Activation must be run automatically.  This is required based on the reading of the device state for NAM.  The menu option for activation is Options > Activation.

Manual Activation
Manual activation page displays a window where the user can enter in information about their device.  The fields are:

·	 ESN – This is not editable
·	 MEID Dec – This is not editable
·	 pESN Hex – This is not editable
·	 Activation Code
·	 Phone Number
·	 MIN
·	 SID
·	� PRL – PRL provides and option to browse on the PC to find the PRL file. After the user enters in their information and selects OK Cricket Broadband Connect programs the 

modem manually

Power Off WWan device
This is used to power the on/off Wireless Internet Card.
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The Help Menu
The Cricket 3G Broadband has a Help section. Please see the Help section for additional questions.

Live update
The Software offers a live update wizard that allows the application to be kept up to date.  The Live Update wizard is a separate application that is integrated into Connection 
Manager.  The application searches on the Internet for new updates based on version numbers and will download and install the update.  This application can be run manually 
or automatically and is launched from the Start menu.
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Guide
Shortcut to the user guide

Help topics
Launches this help file.

You can also access this help file from your UM185C.

About 3G Cricket Broadband
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This chapter addresses the hardware  

installing procedure.

Precautions
Recommended System Requirements

Installing Software
Unplugging or Ejecting the Device
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Precautions 
•	 Once the modem has been inserted into the laptop or desktop computer, do not remove it without first completing the unplugging/ejection process. 

Recommended System Requirements
To successfully install and use the UM185C USB device in your laptop or desktop computer, the following system specifications are required.

  Item	R equired Specification
• Operating system	� Windows® Vista / Windows® XP / Windows® 2000 

Mac OS X 10.4.X (Tiger) or higher

• Connection	 Type A USB port

• Processor	1 66MHz or faster

• Memory	3 2 MB

• Disk space	13 0 MB

Installing Software 

Installation 
•	 If you install Cricket 3G Broadband, it will install the USB Driver for the UM185C. Follow the instructions from the Cricket 3G Broadband for installation.

Warnings!
•	 Make sure to complete the unplugging/ejection process before removing the UM185C. If you remove the device improperly, the product may be damaged.

n	 •  �If you have inserted the device properly, Windows will inform you of the new hardware. Wait until Windows completes the “Found New Hardware” task. In Windows XP, several tool tips 
similar to the “Found New Hardware” function will appear and disappear in the system tray automatically. In Windows Vista, several tool tips similar to the “Installing device driver soft-
ware” function will appear and disappear in the system tray automatically. Once hardware detection is complete, you will be prompted to start activation.

	 •  It is normal to hear a short beep sound each time you insert or remove the UM185C. It is an audible notification that your laptop or desktop computer recognizes the new hardware. 
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Unplugging or Ejecting the Device 
Make sure to complete the unplug/eject process on your computer before removing the UM185C from your PC. If you remove the USB device improperly, the product may be 
damaged.

WINDOWS 
•  �When disconnecting the UM185C from the computer, close all windows and quit all running applications that are stored on the device and double click the Unplug/Eject 

Hardware icon in the System tray.

•  �When you press the Unplug/Eject icon in the system tray, the pop-up window will appear.

•  �Click the [Stop] button. Now, you can remove the UM185C from your PC.

MACINTOSH 
•  �When disconnecting the UM185C from the computer, close all windows and quit all running applications that are stored on the device and drag the device’s icon into the trash 

to dismount it from the Desktop prior to unplugging the device from the USB port or Hub.

        Windows XP                                               Vista

System Tray			          Unplug / Eject Hardware icon
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n	� When removing the UM185C, always grip the top and bottom of the modem and push/pull carefully.
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This chapter addresses the regulatory and  

safety information.

Regulatory Notices
Operating Conditions

Warnings and Cautions
Safety Precautions
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Regulatory Notices 
UM185C complies with Parts 15, 22, and 24 of the FCC rules. It has been tested with a typical personal computer with a USB port. This USB device must not be co-located or 
operated in conjunction with any other antenna or transmitter. If you use this USB device in any other configuration, the FCC RF Exposure compliance limit can be exceeded.

Operating Conditions 
1.	 This device may not cause harmful interference must accept any interference received, including interference that may cause undesirable operations.
2.	 The manufacturer stipulates that the antenna should be more than 1.5 cm (0.60”) from by-standers and 1.0cm (0.39”) from the user. 

Warnings and Cautions 
1.	 Modifying or changing this USB device without express authorization can nullify compliance with RF exposure guidelines.
2.	 This USB device has been tested and found to comply with the limits pursuant to Part 15, 22, and 24 of the FCC Rules. These limits are designed to provide 

reasonable protection against harmful interference when appropriately installed. This USB device generates, uses, and can radiate radio frequency and, if 
not installed and used according to the instructions provided, it may cause harmful interference to radio communication. However, there is no guarantee 
that interference will not occur in any particular installation.

3.	 If this USB device does cause harmful interference with radio or television signals (determine this by turning the USB device off and on), attempt to correct 
the interference by trying one or more of the following: 

	 •  Reorient or relocate the antenna.
	 •  �Increase the separation between the USB device and receiver.
	 •  �Connect the USB device into an outlet on a circuit different from that to which the receiver is connected.
	 •  �Consult the dealer or an experienced radio/TV technician for help.
4.	 This USB device does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference causing equipment 

standard entitled “Digital Apparatus”, ICES-003 of the Department of Communications. 
5.	� If you have purchased this product under a United States Government  contract, it shall be subject to restrictions as set forth in subparagraph (C)(1)(ii) 

of Defense Federal Acquisitions Regulations (DFARs) Section 252.227-7013 for Department of Defense contracts, and as set forth in Federal Acquisitions 
Regulations (FARs) Section 52.227-19 for civilian agency contracts or any successor regulations. If further government regulations apply, it is your 
responsibility to ensure compliance with such regulations. 
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Safety Precautions  
1.	 Data transmission and reception cannot be guaranteed because of the nature of wireless communications. Data can be delayed, corrupted or lost during 

transmission. Even though it is quite rare that significant data delay or loss occurs if the USB device is used in a normal manner, this USB device should 
not be used in cases that data transmission or reception failure could result in damage of any kind to the user or another party, including but not limited 
to personal injury, death or loss of personal property. Personal Communications Devices, LLC. bears no responsibility for damages or losses of any kind 
resulting from delays or errors in data transmission using the USB device, or for failure of the USB device to transmit or receive such data.

2.	 Do not use this USB device in areas where blasting is in progress, where explosive atmospheres may be present, near medical equipment, life support 
equipment, or any equipment which may be susceptible to any form of radio interference. Turn off this USB device in these areas, since it can transmit 
signals that could interfere with this equipment.

3.	 Do not use this USB device in any aircraft whether the aircraft is on the ground or in flight. Make sure to turn off this USB device in aircraft. If used in an 
aircraft, it can transmit signals that could interfere with various aircraft systems.

4.	 Do not use this USB device while driving a car, since it can distract the driver. In some area, using the communication device while driving a car is illegal.

* WARNING: �This product contains a chemical known to the State of California to cause cancer.

* WARNING: �This product contains a chemical known to the State of California to cause birth defects or other reproductive harm.
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Specific Absorption rates (SAR)

Safety Information for RF Exposure
U.S. Federal Communications Commission 

Radio Frequency Interference Statement
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Glossary
Analog Coverage
An area where analog service is available. Analog phones usually indicate signal strength on an indicator in the phone’s display when receiving an analog signal. 
Browser
The software that allows you to view the Internet; contains navigator commands such as forward and back; examples include Netscape, Microsoft Explorer. A Web browser in 
your computer requests HTML files from Web servers and takes you to the Internet sites you wish to visit, by linking your computer’s IP address to a site’s IP address. 
COM PORT (communications port)
A connector for a communications interface, usually, a serial port.
Data
Information kept in databases, on an intranet, on the Internet, etc. 
Driver
Software that controls a device.  
Inactivity Time-Out
A stoppage in a connection, which usually occurs after a period of time elapses, without activity. Time-out settings are usually determined by the network. 
Internet
A cooperatively run, globally distributed collection of computer networks that exchange information via a common set of rules for exchanging data (Transfer Control Protocol/
Internet Protocol or TCP/IP).
Intranet
An intranet is a web site created by a business, which posts its own company information in a secure part of the Internet that only employees or other authorized users can 
reach. Intranets are generally protected by firewalls. 
Kbps
Kilobits per second. 
Kilobyte (KB)
1024 bits (Approximately 1/2 page of plain text)  
Modem
Hardware that translates and transmits data over wire-line or wireless.
Package Minutes
Package minutes are those minutes included in the cost of a monthly service plan. Once the packaged minutes have been exhausted, additional airtime charges apply. Please 
refer to Plans and Pricing for more information, details and offers in your area.
Packet Switching
Packet-switching messages are divided into packets or pieces before transmission over one or more routes and are reassembled at their destination. 
POP3 e-mail
Protocol used by ISP’s mail servers to manage e-mail for subscribers. E-mail clients such as Microsoft Outlook support POP3. 
Proxy Settings
A specific I.P. address that allows access to a secured enterprise network. The proxy settings provide directions to a computer so that it can locate an address and access 
information and services, which exist at that location. 
Search Engine
A program that receives a user’s search request, compares it to the entries in the index, and returns results to help the user find relevant information.
Serial Port
A connector on a computer used to connect peripherals, which communicate using a serial protocol. 
Serial/Data Cable
A wire that connects two serial ports carrying data to one another.
Transmission Speed
The rate at which data is sent over a communications line, usually measured in kilobits (kbps). 
USB Port
A connector on a computer to connect peripherals using USB (Universal Serial Bus) protocol. 
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Specific Absorption rates (SAR)
Maximum: 	SAR 1.19 W/kg CDMA835 Body  
	 SAR 0.854 W/kg PCS1900 Body

THIS MODEL PHONE MEETS THE GOVERNMENT’S REQUIREMENTS FOR EXPOSURE TO RADIO WAVES.

Your wireless phone is a radio transmitter and receiver. It is designed and manufactured not to exceed the emission limits for exposure to radiofrequency (RF) energy set by 
the Federal Communications Commission of the U.S. Government. These limits are part of comprehensive guidelines and establish permitted levels of RF energy for the general 
population. The guidelines are based on standards that were developed by independent scientific organizations through periodic and thorough evaluation of scientific studies. 
The standards include a substantial safety margin designed to assure the safety of all persons, regardless of age and health. The exposure standard for wireless mobile phones 
employs a unit of measurement known as the Specific Absorption Rate, or SAR. The SAR limit set by the FCC is 1.6 W/kg. *

Tests for SAR are conducted with the phone transmitting at its highest certified power level in all tested frequency bands. Although the SAR is determined at the highest 
certified power level, the actual SAR level of the phone while operating can be well below the maximum value. This is because the phone is designed to operate at multiple 
power levels so as to use only the power required to reach the network. In general, the closer you are to a wireless base station antenna, the lower the power output. Before a 
phone model is available for sale to the public, it must be tested and certified to the FCC that it does not exceed the limit established by the government adopted requirement 
for safe exposure. The tests are performed in positions and locations (e.g., at the ear and worn on the body) as required by the FCC for each model. The highest SAR value 
for this model phone when tested for use when worn on the body, as described in this user guide, is 1.19 W/Kg. (Body-worn measurements differ among phone models, 
depending upon available accessories and FCC requirements). While there may be differences between the SAR levels of various phones and at various positions, they all meet 
the government requirement for safe exposure. The FCC has granted an Equipment Authorization for this model phone with all reported SAR levels evaluated as in compliance 
with the FCC RF exposure guidelines. SAR information on this model phone is on file with the FCC and can be found under the Display Grant section of http://www.fcc.gov/oet/
ea/fccid after searching on FCC ID: PP4PX-800.

Additional information on Specific Absorption Rates (SAR) can be found on the Cellular Telecommunications Industry Association (CTIA) web-site at http://www.ctia.org.

* �In the United States and Canada, the SAR limit for mobile phones used by the public is 1.6 watts/kg (W/kg) averaged over one gram of tissue. The standard incorporates a 
sub-stantial margin of safety to give additional protection for the public and to account for any variations in measurements.
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Safety Information for RF Exposure

Body worn operation
This device was tested in multiple notebook computer configurations with USB port configurations for typical near-body operations with the back of the USB Modem kept 5mm 
from the body. To maintain compliance with FCC RF exposure requirements, it can be used in notebook computers with substantially similar physical dimensions, construction, 
electrical and RF characteristics, and that maintain a minimum 20mm separation distance between the user’s body and the back of the USB Modem, including the antenna. The 
antenna(s) used for this USB Modem must not be co-located or must not operate in conjunction with any other antenna or transmitter within a host device.

Safety Information
SAFETY INFORMATION FOR FIXED WIRELESS TERMINALS POTENTIALLY EXPLOSIVE ATMOSPHERES

Turn your phone OFF when in any area with a potentially explosive atmosphere and obey all signs and instructions. Sparks in such areas could cause an explosion or fire 
resulting in bodily injury or even death.

INTERFERENCE TO MEDICAL DEVICES
Certain electronic equipment may be shielded against RF signal from your wireless phone. (Pacemakers, Hearing Aids, and so on) Turn your phone OFF in health care facilities 
when any regulations posted in these areas instruct you to do so. RF signals may affect improperly installed or inadequately shielded electronic system in motor vehicles.

EXPOSURE TO RF ENERGY
Use only the supplied or an approved replacement antenna. Do not touch the antenna unnecessarily when the phone is in use. Do not move the antenna close to, or couching 
any exposed part of the body when making a call.

FCC Compliance Information
This device complies with Part 15 of FCC Rules.

Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and

(2) �This device must accept any interference received.  
This includes interference that may cause undesired operation.
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U.S. Federal Communications Commission Radio Frequency Interference Statement

INFORMATION TO THE USER
NOTE : This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful Interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following measures:

*- �Reorient or relocate the receiving antenna.  
Increase the separation between the equipment and receiver.

*- �Connect the equipment into an outlet of a circuit different from that to which the receiver is connected.

*- �Consult the dealer or an experienced radio/TV technician for assistance. 
Changes or modification not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment. Connecting of peripherals 
requires the use of grounded shielded signal cables.

FCC ID: PP4PX-800

Warning:  
Exposure to Radio Frequency Radiation
The radiated output power of this device is far below the FCC radio frequency exposure limits. Nevertheless, the device should be used in 
such a manner that the potential for human contact during normal operation is minimized. In order to avoid the possibility of exceeding the 
FCC radio frequency exposure limits, human proximity to the antenna should not be less than 20mm during normal operation. The gain of 
the antenna for Cellular band must not exceed 3.5 dBi. The gain of the antenna for PCS band must not exceed 6 dBi. 
The gain of the antenna for AWS band must not exceed 6dBi.


